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ABSTRAKT 

Obsahem této diplomové práce je prozkoumání možností využití protokolu S N M P pro 

správu aktivních prvků, které poskytují služby protokolu Mobile IP. 

První dvě kapitoly se zabývají teoretickým rozborem protokolu Mobile IP a Simple Ne­

twork Management Protokolu. V protokolu Mobile IP se rozbor zaměřuje především na 

prvky domovský agent(Home agent) a cizí agent(Foreign agent). U S N M P protokolu se 

práce zaměřuje nejvíce na jednotlivé způsoby výměny zpráv. 

Další část dokumentu je věnována popisu sestavené laboratorní sítě ze směrovačů Cisco 

1841 a jejich konfiguraci. Nakonec je popsána naprogramovaná aplikace pro správu těchto 

zařízení v jazyce JAVA, která je součástí přílohy. Ta pomocí periodicky zasílaných S N M P 

dotazů zjišťuje stavy vazeb mezi domovským agentem a mobilními uzly, dále pak se­

znam návštěvníků cizího agenta. Aplikace má uživatelsky přívětivé rozhraní, které je 

znázorněno na přiložené flashové animaci. Závěrem práce jsou shrnuty popsané koncepty 

z předchozích kapitol a cíle, kterých se dosáhlo. 

KLÍČOVÁ SLOVA 

S N M P , JAVA, Mobile IP, správa, Cisco 



ABSTRACT 

The content of this thesis is to research possibilities of using S N M P for management of 

Mobile IP activated entities. 

The first two chapters deal with theoretical analysis of Mobile IP protocol, and Simple 

Network Management Protocol. The Mobile IP protocol analysis focuses especially on 

the elements Home agent and Foreign agent. In the S N M P chapter the analysis focuses 

mainly on ways to exchange messages. 

Another part of the document is devoted to a description of laboratory networks com­

posed of routers Cisco 1841 and the configuration of them. Finally is described the 

programmed application to manager these devices in JAVA, which is included in Annex. 

The program periodically sends S N M P queries and finds relationships between the Home 

agent and the mobile nodes, and between the foreign agent and the mobile nodes. The 

application has a user-friendly interface that is shown on the attached flash animation. 

Finally, the thesis summarizes the concepts described in previous chapters and the goals 

to achieve. 
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ÚVOD 

V dnešní době se již bere jako samozřejmost, že osobní počítače a spousta dalších za­

řízení mezi sebou v reálném čase komunikují. V současnosti jsou, ale osobní počítače 

kvůli pevné vazbě s kabeláží vytlačovány menšími a přenosnými zařízeními - note­

booky, netbooky ba dokonce i menšími zařízeními jako kapesní počítače, nebo chytré 

telefony. Ovšem čím menší zařízení vlastníme, tím větší cítíme potřebu mobility. 

Jenže co je to mobilita? První slovo co mě napadne v souvislosti s mobilitou 

je Internet. V dnešní době opravdu velký fenomén, každý jej zná a využívá. Při 

pohledu z vesmíru, se sice tak velký a mocný nezdá, ale pokud zůstaneme na naší 

rodné Zemi, chceme být v rámci Internetu mobilní. 

Tuto mobilitu si můžeme vyložit dvěma způsoby. Na první způsob jsme asi 

všichni zvyklí. Dojdeme do veřejné knihovny, zapneme svůj přenosný počítač, vyhle­

dáme dostupnou bezdrátovou síť, dostaneme IP adresu a prostřednictvím místního 

směrovače jsme připojeni k Internetu. Autor knihy Cisco: Mobilní IP a technologie 

Madhaví W. Chandra člověka, který se takto připojuje, nazývá „kočovník". Tento 

způsob má své nevýhody v tom, že v každé jiné lokalitě se nám mění IP adresa, pod 

kterou vystupujeme v síti Internet. Navíc je tato IP adresa velmi často sdílená více 

uživateli. Právě tady vzniká prostor pro protokol Mobile IP. Pokud potřebuji, abych 

byl dostupný pod jednou konkrétní IP adresou, použiji protokol Mobile IP. Tuto 

potřebu mají často protokoly pro videokonference nebo VoIP jako jsou SIP nebo 

H.323, které se potýkají s problémy pokud se nacházíme za firewallem, nebo naše 

vnitřní privátní adresa je překládána na společnou veřejnou adresu prostřednictvím 

metody NAT overloading. Protokol Mobile IP je tedy, jak říká definice protokolem 

dynamického směrování, jehož koncová zařízení signalizují vlastní aktualizace trasy 

směrování a jehož dynamické tunely odstraňují potřebu šíření trasy k hostiteli. [1]. 

Vlastními slovy bych protokol Mobile IP charakterizoval jako možnost pohybovat 

se v rámci sítě a být neustále dostupný pod stejnou IP adresou. Protokol Mobile 

IP, vyžaduje určitou připravenost sítě poskytovat tyto služby. Tato problematika je 

nastíněna v kapitole 1. 

Protože, mě tato tématika úzce zajímá, zvolil jsem si téma diplomové práce 

9 



„Správa sítí s Mobile IP pomocí SNMP" pod vedením Ing. Skořepy. Pro potřeby 

práce bude sestavena laboratorní počítačová síť tvořená směrovací renomované firmy 

Cisco a běžnými počítači. Zapojení směrovačů je důkladně popsáno v kapitole 3. 

Jelikož v současnosti, není na trhu dostupný software, který by spravoval prvky 

Mobile IP, bude pro tento účel vytvořena aplikace v jazyce JAVA. Ta bude pomocí 

SNMP dotazů spravovat dané prvky. Taková aplikace se dá obecně nazvat jako 

SNMP manager. Aby mohla výměna zpráv probíhat, musí se na druhé straně, na 

směrovacích Cisco, zprovoznit funkce SNMP agenta, který bude na SNMP dotazy 

od managera odpovídat. Aplikace má za úkol takto získaná data vhodně zobrazit a 

dynamicky reagovat na změny v síti. 
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1 MOBILE IP 

Protokol Mobile IP je protokolem mobilní technologie. Tato technologie bývá často 

spojována s bezdrátovou technologií, ale nejsou to synonyma. Bezdrátové sítě pouze 

umožňují mobilním uživatelům (uzlům sítě) pohybovat se napříč sítí bez potřeby 

připojení prostřednictvím kabelů. To ale neznamená, že by se pevného připojení 

nedalo vůbec využít. Naopak této možnosti bylo využito v laboratorní síti, protože 

tak lze přesně určit mobilnímu uzlu, kde se má nacházet. S bezdrátovou technologií 

by tato úloha bylo mnohem složitější, zároveň by neměla žádný vliv na logickou 

strukturu sítě[l]. 

Protokol Mobile IP (MIP) byl stejně jako ostatní internetové protokoly vyví­

jen a schvalován sdružením Internet Engineering Task Force (IETF) od roku 1996 

a v současnosti je popsán v dokumentu R F C 3344. Doplňující funkce pro zabezpe­

čení MIP jsou popsány v dokumentu R F C 4721. V následujících kapitolách bude 

tento protokol podle uvedených dokumentů stručně popsán. 

1.1 Mobile IP v modelu OSI 

Referenční mode Open Systems Interconnection (OSI) je obecně známý model, při 

popisování komunikace v dnešních síťích. Skládá ze sedmi vrstev a komunikace pak 

probíhá na odesílající straně od nejvyšší vrstvy směrem ke nejnižší vrstvě následně 

prostřednictvím komunikačního kanálu se přenese k přijímací straně a přechodem 

od nejnižší vrstvy k nejvyšší přenos zprávy končí. 

Ze znalosti tohoto modelu vyplývá, že nejlepším umístněním pro protokol Mobile 

IP je třetí vrstva, nazývaná síťová. Na této vrstvě je v současnosti dominantní pro­

tokol IPv4, přestože společnost IANA, která spravuje rozdělování IP adres, všechny 

veřejné IP adresy rozdala. 

Díky tomu, že protokol Mobile IP pracuje na této vrstvě, mohou aplikace fungu­

jící na vyšších vrstvách pracovat, bez toho aniž by poznaly jak se logická struktura 

na síťové vrstvě mění. Analogicky toto funguje směrem k nižším vrstvám, je úplně 

jedno zda použijeme pevné sítě Ethernet nebo některou z dostupných bezdrátových 
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sítí. Pokud ale použijeme bezdrátové technologie, dokáže protokol Mobile IP s linko­

vou vrstvou úzce spolupracovat a předávání mezi jednotlivými přístupovými body 

se stává mnohem rychlejší a může vézt až k naprosto plynulému přechodu mezi 

sítěmi [1]. 

1.2 Základní prvky MIP 

Mobile IPv4 obecně pracuje nad směrovacím protokolem, nejlépe ze skupiny Link-

state např. Open shortest path first (OSPF) do kterého se redistribuuje. Mezi zá­

kladní prvky patř í 1 : 

• Domovský agent (Home agent) 

• Cizí agent (Foreign agent) 

• Mobilní uzel (Mobile node) 

V následujících kapitolách budou tyto prvky stručně popsány. 

1.2.1 Domovský agent — Home agent 

Domovský agent neboli Home agent (HA) je stěžejním prvkem protokolu MIP. Tento 

prvek definuje domovskou síť, kde jsou mobilní uzly doma, udržuje jejich seznam. 

Dále domovský agent musí definovat jaká autentizace se bude používat s daným 

mobilním hostem. Na výběr je hexadecimální klíč o délce 32 znaků pro menší počet 

uživatelů. Pro velké počty uživatelů je vhodnější využít A A A serveru(autentizace, 

autorizace, accounting)serveru nazývaného Remote Authentication Dial In User 

Service (RÁDIUS) [3]. 

Mobile IP funguje tak, že všechen provoz pro mobilní uzel je nejprve směrován do 

domovské sítě, kterou spravuje domovský agent. Ten podle toho kde se mobilní 

uzel nachází rozhodne, kam se provoz přesměruje. Pokud se mobilní uzel nenachází 

v domácí síti vytvoří tunel směrem k cizímu agentovi u kterého je mobilní uzel 

připojen. Tímto tunelem se pak přenáší veškerý provoz určený pro mobilní uzel. 

Provoz ve směru od mobilního uzlu může putovat dvěma způsoby. Buď tunelová­

ním zpět k domovskému agentovi, nebo přímo ke korespondujícímu uzlu. V druhém 
1Prvek Correspondent node není uveden, protože Mobile IP vůbec nemusí podporovat 
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případě vzniká tzv. trojúhelníkové směrování, které lze realizovat pouze v rámci 

autonomního systému[2]. Situace je znázorněna na obr. 1.1. 

Domovský agent Domovský agent 

Obr. 1.1: Vlevo trojúhelníkové směrování, vpravo zpětné tunelování 

Hlavní důvod, proč mobilní uzel jednoduše neuvědomí korespondující uzel o svém 

novém umístnění a nevytvoří symetrickou směrovací trasu, lze popsat jediným slo­

vem - zabezpečení. Způsoby zabezpečení jsou popsány v kapitole 1.3[1]. 

1.2.2 Cizí agent — Foreign agent 

Cizí agent FA je směrovač, který zprostředkovává mobilní služby pro mobilní uzel, 

které se nachází v jeho dosahu. Základní funkcí je předávání registračních žádostí 

mezi mobilním uzlem a domovským agentem. Dále poskytuje tzv. Care of Address 

(CoA), která představuje logické umístnění mobilního uzlu v síti. Po úspěšné regis­

traci sestavuje mobilním uzlům tunel, kterým se přenáší provoz mezi daným mobil­

ním uzlem a domovským agentemMN[2]. 

1.2.3 Mobile node — mobilní uzel 

Tento prvek představuje účastnické zařízení, které může přecházet mezi různými 

sítěmi a je přitom dostupné přes svou domovskou adresu. Pokud je mobilní uzel 
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připojen u domovského agenta protokol MIP se při směrování paketů neprojeví. 

Teprve až se připojí k jiné síti zjišťuje zda se v ní nachází cizí agent, který mu 

zprostředkuje spojení s domovským agentem prostřednictvím CoA. Tu zjistí z pra­

videlně vysílaných agent advertisement na rozhraní kde cizí agent poskytuje MIP 

služby. Tyto oznámení jsou šířeny ICMP Router Discovery Messages (IRDP) pro­

tokolem všesměrově. Pokud se v síti cizího agenta nenachází, tak se mobilní uzel 

pokusí sám navázat tunel s domovským agentem prostřednictvím Co-located Care 

of Address (CCoA)[2][7]. 

1.3 Zabezpečení v protokolu Mobile IP 

Aby si mobilní uzel a korespondující uzel mohly během procesu registrace proto­

kolu Mobile IP vyměňovat informace o tom, kde se mobilní uzel nachází, musí mezi 

nimi existovat vztah důvěry. V opačném případě by byla komunikace mezi uzly sítě 

jednoduše napadnutelná útoky typu DoS, dle mého názoru i M i t M . Uzel útočníka 

by mohl posla korespondujícímu uzlu falešnou registrační zprávu s falešnou adresou 

CoA a snadno by unesl navázané spojení. Musel by se použít nějaký systém např. 

certifikační autority, která by poskytovala důvěrnost mezi uzly. To by vyžadovalo 

i implementaci na straně korespondujícího uzlu. Proto protokol Mobile IP tento pro­

blém řeší tak, že mobilní uzel se registruje k domovskému agentu. Vztah důvěrnosti 

je tedy mobilní uzel - domovský agent. Provoz od korespondujícího uzlu je stan­

dardně směrován nejprve do domovské sítě a teprve domovský agent rozhodne kam 

dál bude směrován. Provoz od mobilního uzlu směrem ke korespondujícímu uzlu 

jde již přímo. Díky tomu vzniká typické, pro protokol Mobile IP, trojúhelníkové 

směrování. 

Směrování protokolu IP z jeho definice používá cílovou adresu a nezohledňuje 

zdrojovou. Protokol Mobile IP tohoto faktu využívá pro optimalizaci doručování 

provozu. Mobilní uzel nacházející se v cizí síti tak může jako zdrojovou adresu použít 

svou domovskou adresu aniž by se v domovské síti nacházel. 

Metody zabezpečení jsou v tomto protokolu určeny pouze k ochraně řídícího 

provozu, jmenovitě žádosti o registraci a potvrzení registrace. Nej důležitějším úko-

14 



lem je správně ověřit totožnost a bránit se proti útoku přehrání již proběhlé relace. 

Pro ověření totožnosti se využívá algoritmu H M A C definovaného v dokumentu R F C 

2014. Pro nejjednodušší konfiguraci přidružení zabezpečení je možné využít kontextu 

identifikovaného hodnotou Security Parametr Index (SPI) s bezpečnostním klíčem. 

Toto přidružování je ale pro konfiguraci celkem složité a náročné na údržbu (klíče 

jsou v konfiguračních souborech směrovačů uchovávaný nešifrovaně), proto je v pří­

padě nasazení v praxi vhodnější využít serveru A A A . Jako metoda pro zabezpečení 

před přehráním proběhlé relace se používá metoda časového razítka timestamp[l]. 

1.4 Správa domovské adresy mobilních uzlů 

V systému IOS je podpora možná správa přidělován domovské adresy třemi způsoby: 

• Statické přidělování adresy bez identifikátoru Network Access Identifier (NAI) 

• Statické přidělování adresy s identifikátorem NAI 

• Dynamické přidělování adres s identifikátorem NAI 

V práci bude využito první metody, a proto bych její podstatu ve zkratce nastínil. 

Statické adresy se předem v mobilních uzlech a jsou jejich jednoznačnými identifi­

kátory. Tím pádem jsou vlastníky pevně dané dosažitelné IP adresy, což je velkou 

výhodou. Každá výhoda má i svou nevýhodu a tady se skrývá v malé škálovatelnosti. 

Je zapotřebí ve všech mobilních uzlech předem nakonfigurovat domovské adresy[1]. 

Tuto adresu pak může používat pouze jeden mobilní uzel - plýtvání adresním pro­

storem. Pro malou síť jako je laboratorní, je však tato metoda plně vyhovující. 

1.4.1 Domovská síť 

Všechny domovské adresy bez ohledu na způsob přidělování adresy musí být přidru­

ženy k domovské síti, která je přímo připojena k domovskému agentovi. Domovskou 

síť tedy tvoří prefix, společný pro mobilní uzly. Existují dva způsoby jak v systému 

IOS domovskou síť definovat: 

• Fyzická síť přidružená k jednomu z rozhraní 

• Virtuální síť 
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Obecně se předpokládá, že mobilní uzel bude připojen k fyzické síti. Tato možnost se 

nejvíce využívá, když mobilní uzel většinu času tráví v domovské síti. Tato metoda 

má ale jednu nevýhodu, pokud se mobilní uzel nachází mimo domácí síť a rozhraní 

domovského agenta z nějakého důvodu selže, tak se mobilní uzel nemůže k domovské 

síti registrovat. Pokud ale předpokládáme, že většinu času bude mobilní uzel mimo 

domovskou síť, je vhodné jej přiřadit do tzv. virtuální sítě. Tato síť má výhodu 

v tom, že je vždy dostupná, nezávisí na žádném rozhraní. O uzlu, který se nikdy 

nenachází v domovské síti říkáme, že je uzel s trvalým roamingem. Ve skutečném 

nasazení mohou kvůli tomu vzniknout určité problémy se sémantikou. Mobilní uzel 

může být připojen u domovského agenta, ale bude jej využívat, jako by byl v cizí síti. 

Virtuální síť lze přirovnat k rozhraní zpětné smyčky a v systému IOS se konfiguruje 

tímto způsobem: 

ip mobile virtual—network p ref ix maska 

Po nadefinování této virtuální sítě, lze přiřadit jednotlivé mobilní uzly do této 

sítě následujícím příkazem: 

ip mobile host address virtual—network p re f ix maska 

V případě, že použijeme přiřazení k fyzické síti je třeba použít tohoto příkazu: 

ip mobile host address interface název 

Nakonec je potřeba vytvořit povinné přidružení zabezpečení mezi domovským 

agentem a mobilnímy uzly: 

ip mobile secure host address spi index_spi key hex ř e t ě z e c k l í č e 

algorithm n á z e v . a l g o r i t m u 

Tím je konfigurace přidružení ze strany domovského agenta dokončena[l]. 
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2 SIMPLE NETWORK M A N A G E M E N T PRO­

TOCOL 

V dnešní době je často náš životní styl ovlivněn Internetem. Stáváme se závislými na 

připojení k internetu, firmy při výpadku připojení přichází o nemalé peníze. V těchto 

případech potřebujeme nějakým způsobem dohlížet na chod prvků, které nás spo­

jují - směrovače, přepínače atd. Takové sítě jsou již v praxi velmi rozsáhlé, což vede 

k jejich nepřehlednost. Porucha, nebo přetížení jednoho prvku může často zname­

nat kolaps. Právě proto již v roce 1988 vznikl protokol Simple Network Management 

Protocol (SNMP) definovaný v R F C 1067, který měl za cíl vzdáleně spravovat prvky 

sítě a neustále nad nimi dohlížet. O 2 roky později byl dokument R F C 1067 aktua­

lizován dokumentem R F C 1157. 

Díky škálovatelnosti tohoto protokolu lze s jeho pomocí spravovat vše od výkonných 

Cisco přepínačů a směrovačů až po mikrovlnou troubu vybavenou W i - F i adaptérem. 

Jedinou podmínkou je, aby zařízení pracovalo nad IP protokolem. Hranice využi­

telnosti protokolu, jsou téměř nekonečné, především ale jde o sbírání statistik nebo 

stavových informací ze síťových zařízení. Dále umožňuje i vzdáleně daná zařízení 

konfigurovat. Tato výměna zpráv probíhá následovně - SNMP manager se dota­

zuje na konkrétní hodnoty v databázi a agent pokud zná odpověď odpovídá. Další 

možností výměny informací, jsou varovné zprávy trap. Tyto zprávy zasílá agent bez 

výzvy managera, pokud zaznamená nastavenou kritickou situaci. 

Ve zkratce se tedy jedná o aplikační protokol, pomocí kterého se zjišťují nebo 

nastavují hodnoty agentovy databáze MIB. 

2.1 Architektura SNMP 

SNMP pracuje na architektuře agent/manager. Síťová zařízení, která sledujeme, 

představují agentskou část architektury. Jejich počet může být teoreticky neomezen. 

Aplikace, která běží na takovém zařízení se nazývá SNMP agent. Sledující zařízení 

je v síti typicky jen jedno, ale může jich být i více na sobě nezávislých. Program 

běžící na takovém zařízení se nazývá SNMP manager[4] [5]. Tento program může 

17 



být zabudován v operačním systému aktivního prvku, nebo běžet jako samostatná 

aplikace na osobním počítači. Naprogramování takové aplikace v jazyce JAVA bude 

cílem této práce. 

2.2 Verze SNMP 

Protokol SNMP v současnosti existuje ve 3 verzích, které se liší hlavně podporova­

nými funkcemi, ale cíl mají stejný. Nejvíce se využívá verze 2c, která oproti verzi 

1 podporuje zprávu typu GetBulk. Tento typ zprávy umožňuje v jednom paketu pře­

nést více než jednu dotazovanou hodnotu. SNMP verze 3 zavádí podporu šifrování. 

Srovnání rozdílů je na tabulce 2.1. 

Tab. 2.1: Hlavní rozdíly ve verzi SNMP 

S N M P v l SNMPv2c SNMPv3 

Get X X X 

Set X X X 

GetNext X X X 

Trap X X X 

GetBulk X X 

Šifrování X 

2.3 Management Information Base 

Spravované objekty(hodnoty) jsou dostupné přes virtuální úložiště, známé jako Ma­

nagement Information Base (MIB). Objekty v MIB jsou definovány jazykem Structure 

of Management Information (SMI), který využívá základu z jazyka Abstract Syntax 

Notation One (ASN.l) . Z takto definovaných objektů se vytvářejí MIB ve stromové 

struktuře. Databáze je tak logicky rozdělena do přehledných částí. 

Takto definované databáze jsou normalizovány, schvalovány a dokumentovány 

v jednotlivých R F C např R F C 2233, v případě potřeby i společnosti jako je Cisco 
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mohou vytvářet své vlastní MIß. V současnosti jich existuje nespočetné množství. 

Protože cílem práce bude vytvoření aplikace pro správu Mobile IP budu se zabý­

vat pouze MIP-MIB definované v R F C 2006. Dále budu využívat MIB definované 

společností Cisco CISCO-MOBILE-IP-MIB. Definice je dostupná na této adrese 

„ftp://ftp.cisco.com/pub/mibs/v2/CISCO-MOBILE-IP-MIB.my" a je i na přilože­

ném CD. 

2.4 Object Identifier 

Každá instance libovolného objektu definovaného v MIB má 2 identifikátory: číselný 

a slovní. Číselný identifikátor umožňuje hierarchicky uspořádávat objekty v MIB. 

Je tvořen číslicemi oddělenými tečkou. Protože je takto zapsaný identifikátor pro 

člověka špatně čitelný, ke každému číselnému identifikátoru přiřazujeme slovní iden­

tifikátor. Díky němu jsme si schopni jednoduše odvodit jakou hodnotu daný objekt 

představuje. Např. OID 1.3.6.1.2.1.1.5 představuje sysName známé jako hostname. 

Pokud hodnotu potřebujeme přímo vyčíst musíme na konec OID přidat .0 jako 

číslo instance1. Dále je patrné, že i textové výrazy vykazují určitou hierarchii. Např. 

objekt if Number patří do databáze IF-MIB a označuje počet síťových rozhraní na 

daném zařízení. Příklad zápisu MIB objektu v MIB databázi: 

ifNumber OBJECT-TYPE 

SYNTAX Integer32 

MAX-ACCESS read-only 

STATUS current 

DESCRIPTION 

"The number of network interfaces (regardless of their 

current state) present on this system." 

::= { interfaces 1 } 

1sysName má pouze 1 instanci 
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2.5 Výměna zpráv 

Výměna zpráv probíhá asynchronně, tzn. bez ohledu na stav prvků v síti. SNMP 

manager se dotazuje SNMP agenta a ten odpovídá. Každý dotaz může obsahovat 

žádost i na více než jeden objekt, velikost dotazu je omezena pouze maximální pod­

porovanou velikostí zprávy. Jednotlivé údaje dotazu nazýváme variable binding, což 

je spojení OID a návratové hodnoty daného objektu. Dotazy mohou být následují­

cího typu [6]: 

GetRequest 

Zpráva typu GetRequest je generována aplikací SNMP manager a následně odeslána 

na požadovanou cílovou adresu SNMP agenta. Jedná se o nejjednodušší možný do­

taz, využívá se hlavně pro čtení objektů, které mají pouze jednu instanci. 

GetNext Request 

Tato zpráva je stejně jako předešlá generována SNMP managerem. Nevrací však 

hodnotu objektu, ale OID následujícího objektu. S kombinací zprávy GetRequest je 

možné tedy v kombinaci s dotazy typu GetRequest procházet MIB databázi. Tento 

způsob se však jeví jako nevhodný pro velké množství dotazů a odpovědí. Z tohoto 

důvodu SNMPv2 zavádí dotaz typu GetBulk. 

GetBulk 

Díky této zprávě lze přenášet velké množství informací. Při použití této zprávy 

je nutné nastavit hodnoty non-repeaters a max-repetitions. První jmenovaná hod­

nota udává kolik objektů se má považovat za skalární, tedy vyčítat pouze metodou 

GetRequest. Druhá hodnota říká, kolikrát se má maximálně použít metoda Get-

NextRequest. Celkový počet odpovědí lze spočítat ze vzorce N + M x R, kde N je 

non-repeaters, M je max-repetitions a R = Celkový počet proměnných OID v dotazu 

mínus N . Mějme tedy dotaz o deseti proměnných OID, z toho tři jsou typu non-

repeaters a z ostatních chceme vyčíst maximálně 4 řádky. Po dosazení do vzorce 

3 + 4 x (10-3) dostáváme 31 údajů. 
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SetRequest 

SNMP kromě získávání informací z agentů, umožňuje vybrané objekty vytvářet 

nebo modifikovat. K tomuto účelu slouží SetRequest. Pokud by se v praxi této 

možnosti využívalo, silně doporučuji z bezpečnostního hlediska využít SNMPv3, 

které umožňuje šifrování a autentizaci. 

Response 

Jak název napovídá, jedná se o odpověď agenta managerovi. Odpovědi se zasílají 

ve formě variable binding, tzn. vrací se OID společně s hodnotou. 

Trap 

Tuto zprávu vytváří agenti pokud zaznamenají nastavenou událost. Pokud se vy­

užívá, správa sítě se stává mnohem dynamičtější, protože manager na tuto zprávu 

může okamžitě reagovat. 

2.5.1 Formát zprávy 

Zprávy se zapisují a přenášejí strukturované podle anotace A S N . l . Ta využívá kó­

dování Basic Encoding Rules (BER). Obecný formát zprávy pak vypadá takto[6]: 

PDU : := SEQUENCE { 

r eques t - id MTEGER (-214783648..214783647) , 

error—status — v n ě k t e r ý c h p ř í p a d e c h se neuvádí 

INTEGER { 

n o E r r o r ( 0 ) , 

}, 
error—index — v n ě k t e r ý c h p ř í p a d e c h se neuvádí 

INTEGER (0 . .max-b ind ings ) , 

variable—bindings 

V a r B i n d L i s t 

} 
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2.5.2 Přenosový protokol 

Pro přenos dat mezi entitami se využívá U D P protokol. Pro SNMP jsou vyhrazeny 

porty 161 a 162. Port 161 se využívá jako zdrojový při odeslání dotazu, nebo jako 

cílový při odesílání odpovědí. Port 162 je vyhrazen pro SNMO managera pro příjem 

trapů. [6] 

2.5.3 Chybové zprávy SNMP protokolu — výjimky 

V určitých situacích může dojít k tomu, že SNMP agent nezná odpověď a proto 

je potřeba vědět jak takové výjimky ošetřit. Pokud by agent vrátil pouze prázdnou 

hodnotu, nevěděli bychom, zdaje prázdná, nebo nastala výjimka. Díky implementaci 

výjimek se také nemůže stát, že by agent zkolaboval při dotazu na neznámý objekt. 

Seznam nejčastějších výjimek podle R F C 3416 je uveden v tabulce 2.2. [6] Daná vý-

Tab. 2.2: Nejčastější výjimky 

Název Index Význam 

noError 0 žádná výjimka nenastala 

tooBig 1 velikost P D U odpovědi je příliš velká pro přenos 

noSuchName 2 název dotazovaného objektu nebyl nalezen 

readOnly 4 byl zaslán příkaz Set na hodnotu „read only" 

authorizationError 16 špatná autorizace 

jimka je oznamována v poli error-status pouze svým indexem z tabulky(2.2) a 

pole error-index udává, pro kterou hodnotu z VarBindList je výjimka oznamo­

vána. 
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3 VYPRACOVÁNI 

3.1 Testovací síť 

Testovací síť pro účel mé práce bude tvořena směrovací od renomované firmy Cisco 

modelové řady 1841 s verzí IOS 12.4. Navržená fyzická topologie je znázorněna na 

obrázku 3.1. V praxi je ovšem toto zapojení samozřejmě nesmyslné. V laboratoři 

má pouze za úkol simulovat logické zapojení, znázorněné na obrázku 3.2. 

Korespondující uzel 

Obr. 3.1: Fyzická topologie laboratorní sítě 

Jsou zde celkem 4 směrovače, 1 přepínač a 2 běžné počítače. Sítě začínající 

prefixem lO.O.x.x představují internetové sítě, 192.168.x.x domovskou síť a 172.16.x.x 

jsou cizí sítě. Kompletní nastavení jednotlivých směrovačů je uvedeno v příloze. 

V následujících kapitolách budou uvedeny nej důležitější kroky pro nastavení. 
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Obr. 3.2: Logická topologie laboratorní sítě 

3.1.1 Internetové řešení — Internet solution 

Prostřední směrovač s názvem Internet solution (IS) velice zjednodušeně simuluje 
internetové prostředí. Je na něm spuštěn zvolený směrovací protokol OSPF, který 
zaručuje velice rychlou konvergenci a adaptabilitu sítě. Dále poskytuje připojení pro 
C N . U tohoto směrovače je nejdůležitější správné nastavení. To se provede zadáním 
následujících příkazů do konzole IOS v konfiguračním režimu: 

router ospf 1 

network 10.0.0.0 0.0.255.255 area 0 

network 145.229.1.0 0.0.0.255 area 0 

Směrovače firmy CISCO mají standardně pouze dva Fast Ethernetové porty 
v úloze. U jednoho směrovače, ale potřebujeme alespoň čtyři. Jako nejjednodušší 
řešení v laboratorních podmínkách se jeví použití přídavného switch modulu. Jed­
notlivé porty „switch" modulu jsou zařazeny do různých V L A N . Každá V L A N má 
pak vytvořeno své vlastní rozhraní na síťové vrstvě, čímž se z modulu pracujícího 
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na linkové vrstvě stane zařízení pracující na vrstvě síťové1. 

interface FastEthernetO/0/0 

switchport access vlan 10 

interface FastEthernetO/0/1 

switchport access vlan 11 

1 

interface VlanlO 

ip address 10.0.0.1 255.255 255 0 

interface Vlanll 

ip address 10.0.1.1 255.255 255 0 

Poznámka 

Během studia Cisco akademie C C N P - Switching, jsem se ale dozvěděl o mnohem 

elegantnějším způsobu. Na jednotlivých rozhraních stačí použít příkaz no switchport 

a rozhraní se začne chovat jako běžné rozhraní na síťové vrstvě, kterému lze standard­

ním příkazem ip address přiřadit IP adresu. Síť ale fungovala i podle předešlého 

nastavení, tak jsem se řídil heslem „If it works, don't fix it!". Česky řečeno pokud 

to funguje, neopravuj to! 

3.1.2 Domovský agent — Home agent 

Služby domovského agenta jsou zprovozněny na levém směrovací. Funkce Mobile IP 
se na směrovací aktivuje zadáním příkazu router mobile. Dále je potřeba protokol 
MIP redistribuovat do směrovacího protokolu: 

router ospf 1 

redistribute mobile subnets 

Výraz subnets na konci příkazu znamená, že se budou přenášet i masky podsítí. 
Pokud by se tato informace nepřenášela, směrovač by masku odvodil podle třídy 
IP adresy. Příkazem ip mobile home-agent se určí, že směrovač má tuto funkci. 
Přiřazení mobilních uzlů lze provézt dvěma způsoby. V prvním případě musíme 
mít vytvořenou domovskou síť na jednom z rozhraní a do této sítě mobilní uzly 

Mle ISO/OSI modelu 
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přiřazujeme. Toto řešení má jistou nevýhodu v tom, že když je dané rozhraní ve stavu 
„DOWN", mobilní uzly nejsou schopny se ani z cizí sítě přiřadit k domovskému 
agentovi, protože jejich domovská síť je nedostupná.  

interface FastEthernetO/0/0 

ip address 192.168.100.1 255.255.255.0 

! 

ip mobile home-agent address 192.168.100.1 

ip mobile host 192.168.100.10 192.168.100.20 interface faO/0/0 lifetime 100 

Druhá možnost tento problém řeší přiřazením mobilních uzlů do virtuální sítě, 

což se jeví jako vhodnější řešení[1]: 

ip mobile home-agent address 192.168.100.1 

ip mobile virtual-network 192.168.100.0 255.255.255.0 

ip mobile host 192.168.100.10 192.168.100.20 virtual-network 192.168.100.0 

255.255.255.0 lifetime 100 

3.1.3 Cizí agenti — Foreign agenti 

Konfigurace dvou znázorněných cizích agentů se liší pouze v IP adresách, jinak je 
konfigurace identická. Stejně jako u domovského agenta je potřeba aktivovat funkci 
MIP a nastavit redistribuci do OSPF. Služby FA, nastavení CoA a IRDP protokolu 
jsou aktivovány následujícími příkazy: 

interface FastEthernetO/1 

ip address 172.16.1.1 255.255.255.0 

ip mobile foreign-service 

ip irdp 

ip irdp maxadvertinterval 4 

ip irdp minadvertinterval 3 

ip irdp holdtime 9 

ip mobile foreign-agent care-of FastEthernetO/1 

ip mobile foreign-service 
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3.1.4 Přepínač 

Znázorněný přepínač připojené sítě nespojuje do jedné všesměrové(broadcastové) 
domény, ale pomocí Virtual Local Area Network (VLAN) je všechny odděluje. Pře­
pnutím V L A N na portu mobilního uzlu je docíleno simulování cestování mobil­
ního uzlu. Pro rychlejší navázání spojení je vhodné u daných rozhraních nastavit 
switchport host, což je standardně vytvořené makro v IOS pro příkazy: 

Switch(config)#interface range fastEthernet 0/1 - 48 

switchport mode access 

spanning-tree portfast 

no channel-group 

Pomocí prvního příkazu se dostaneme z globálního konfiguračního režimu do 

režimu konfigurace rozhraní portů „Fast Ethernet" 1 až 48. Další příkazy jsou ob­

saženy v uvedeném makru. První příkaz nastaví pevně port jako přístupový. Často 

bývá u zařízení Cisco nastaven mód jako dynamický, což vede ke zdržení, protože 

přepínač zjišťuje, zda se na druhém konci nenachází také přepínač a nebylo by tedy 

vhodnější nastavit port jako trunk 2. Druhý příkaz řekne protokolu „Spanning tree" 

aby rozhraní přivedl okamžitě do aktivovaného stavu a neočekával, že by mohla na­

stat smyčka. Toto nastavení se silně nedoporučuje při propojování více přepínačů. 

Poslední příkaz vyřadí port ze skupiny „EtherChannel" pokud v nějaké byl. 

3.1.5 Konfigurace SNMP 

V diplomové práci budu pracovat s SNMPv2c, díky tomu stačí nastavit pouze ko­
munitu pro čtení SNMP údajů:  

snmp-server community public R0 

Název komunity je public a parametr R0 znamená ReadOnly. 

3.1.6 Mobile node — Mobilní uzel 

Funkce mobilního uzlu jsou zprovozněny na laboratorním P C s operačním systémem 
Windows X P a nainstalovaným softwarem Cisco mobile client verze 2.0.143. Jelikož 

2trunk je schopen na jednom rozhraní přenášet data více než jedné V L A N 
3software je podporován pouze pro Windows XP 
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tento software ne vždy pracuje správně, je někdy potřeba jej opakovaně restartovat, 
a dokonce je někdy nutné restartovat celý operační systém . Hlavním problémem 
je, že klient při změně nastavení neaplikuje správně nové nastavení. Přijímající do­
movský agent nebo cizí agent, pak takovou zprávu se špatným nastavením může 
zamítnout. Pro odstranění tohoto problému je vhodné zapnout na směrovací debug: 
debug i p mobile. Konfigurace mobilního klienta je uložena v profilovém souboru 
s koncovkou .mcprof ile. Obsah tohoto souboru je uveden v příloze B.5. Výpis de-
bugu domovského agenta s navázáním mobilní vazby4: 

MobilelP: HA 262 rev registration for MN 192.168.100.10 

on FastEthernetO/0 using HomeAddr 192.168.100.10 C0A 172.16.1.1 HA 10.0.0.3 

lifetime 36000 options sbdmg-t- identification D0AB8E5C2900237B 

MobilelP: UDP Tunnel Request rejected 

MobilelP: Authenticating MN 192.168.100.10 using SPI 100 

MobilelP: Authentication algorithm HMAC-MD5 and 16 byte key 

MobilelP: Authenticated MN 192.168.100.10 using SPI 100 and 16 byte key 

MobilelP: Mobility binding for MN 192.168.100.10 updated - tunnel changed 

7
0
LINEPROTO-5-UPDOWN: Line protocol on Interface Tunnell, changed state to up 

MobilelP: Tunnell (IP/IP) created with sre 10.0.0.3 dst 172.16.1.1 

MobilelP: MN 192.168.100.10 Tunnel route deleted for 192.168.100.10 

via gateway 192.168.100.100 

MobilelP: Deleted TunnelO sre 10.0.0.3 dest 192.168.100.100 

MobilelP: MN 192.168.100.10 Insert route for 192.168.100.10/255.255.255.255 

via gateway 172.16.1.1 (metric 1) on Tunnell 

Null mn or mn->aaa_id in ipmobile_aaa_acct_net_update 

MobilelP: Roam timer started for MN 192.168.100.10 using 192.168.100.10, 

MobilelP: HA accepts registration from MN 192.168.100.10 

MobilelP: Dynamic and Static Network Extension Length 0 - 0 

MobilelP: Sending Registration Reply message for MN 192.168.100.10 with 

Lifetime 36000, Home Address 192.168.100.10, Home Agent 10.0.0.3 Code 0 

MobilelP: Composed mobile network extension length:0 

MobilelP: Authentication algorithm HMAC-MD5 and 16 byte key 

MobilelP: MN 192.168.100.10 MHAE added to MN 192.168.100.10 using SPI 100 

MobilelP: MN 192.168.100.10 - HA sent reply to 172.16.1.1 

4angl. Mobile binding 
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4 SPRÁVA MOBILE IP POMOCI SNMP 

Téma práce vzešlo z neexistence programu, který by spravoval prvky Mobile IP, a 

proto jsem si kladl za cíl vytvořit program, který bude lehké používat nezávisle na 

operačním systému a zároveň pokryje požadavky na něj kladené. Program jsem se 

rozhodl napsat v jazyce JAVA. Bude představovat SNMP manager spravující aktivní 

prvky testovací sítě (3.1). Funkční základ programu pro komunikaci prostřednictvím 

SNMP protokolu tvoří Application Programming Interface (API) s názvem SNMP4J 

z balíčku org.snmp4j .x. Uživatelské rozhraní je vytvořeno ze standardních prvků 

balíčku javax.swing.*. Pro ukládání nastavení do X M L souborů bylo využito ba­

líčků javax.xml.* a org.w3c.dom.*. 

4.1 Požadavky na aplikaci 

Před vývojem aplikace je nutné stanovit, jak se má aplikace v daných situacích 

chovat a jaké schopnosti má mít. Podle zadání má aplikace sledovat stav agentů 

protokolu MIPv4. To znamená zjišťovat především navázané vazby mezi domov­

ským agentem a mobilním uzlem. Z této vazby lze následně určit, zda se mobilní 

uzel nachází v domácí síti domovského agenta, zda využívá některé sítě a CoA ci­

zích agentů nebo se nachází někde v internetu, tunel si sestavuje sám použitím 

CCoA. Tím se pokryla i požadovaná funkce monitorování aktivity mobilních uzlů. 

Tyto funkce jsem považoval za hlavní a jsem rád, že se mi je podařilo velmi dobře 

implementovat. Na následujících stránkách, se pokusím přiblížit tuto implementaci. 

Dalším úkolem bylo umožnit nastavování stavu agentů. Při bližším zkoumání se 

ale ukázalo, že je jen málo objektů v SNMP databázi lze modifikovat, a proto jsem 

tuto funkci neimplementoval. Jedním z takových objektů je mipEnable, který indi­

kuje zda je protokol Mobile IP na dané entitě aktivovaný. Při pokusu o deaktivaci a 

následnou aktivaci prostřednictvím SNMP došlo ke kompletnímu smazání nastavení 

MIP, a proto tato funkce není implementována. 
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4.2 API SNMP4J 

Před vývojem aplikace je nutné se rozhodnout, zda si programátor všechny funkce 

potřebné pro běh programu napíše sám nebo se rozhodne využít některého z do­

stupných API . První případ představuje zbytečně složitou a trnitou cestu, protože 

v dnešní době je dostupné velké množství i opensource API . Díky těmto A P I se 

programátor nemusí dopodrobna starat o základní funkce, ale může využít funkcí 

vyšších dostupných z API . 

Jedním takovým A P I je SNMP4J. Jedná se, dle mého názoru, o velice detailně a kva­

litně zpracované A P I pro jazyk JAVA. Je poskytováno zdarma z webu projektu: 

www.snmp4j.org. Má plně otevřený kód pod licencí Apache 2.0. S jeho využitím 

lze sestavit jak SNMP managera tak i SNMP agenta. A P I obsahuje i implementaci 

SNMPv3, tudíž prostředky všechny prostředky pro zabezpečení komunikace jsou 

dostupné. 

V mé práci jsem využil pouze zlomek tříd a funkcí z SNMP4J, což dokazuje jeho 

komplexnost a potenciál pro dobrý vývoj. 

4.3 Vývoj vlastní aplikace 

Pro vývoj vlastní aplikace bylo využito vývojového prostředí NetBeans verze 6.9.1. 

V prostředí je nutno nejdříve vytvořit projekt a do něj naimportovat požadované 

A P I SNMP4J. V době psaní práce byla dostupná verze zdrojových kódů 1.11.2. 

Stažený soubor snmp4j-1.11.2-distribution.zip obsahuje složky: 

snmp4j -1.11.2/ / / k o ř e n o v á s ložka 

d is t / / /obsahuje zkompi lované soubory * . ja r 

l i b / / / kn ihovny p o t ř e b n é p ř i vývoj i b a l í č k u SNMP4J 

mibs / / / d a t a b á z o v é MIB soubory 

src / / / z d r o j o v é kódy projektu 

Aby bylo možné ve vlastním projektu využít balíčku, je potřeba v NetBeans vy­

tvořit vlastní knihovnu, do které se následně naimportuje soubor snmp4 j -1.11.2. j ar 

Dále je vhodné si přidat i soubor snmp4j -1.11.2-j avadoc. j ar do záložky javadoc, 
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diky kterému se práce v NetBeans stává mnohem pohodlnější díky nápovědě během 

programování. Správný import knihovny je znázorněn na obrázku 4.1. V následu­

jících sekcích budou popsány jednotlivé třídy a funkce programu, které vytvářejí 

balíček cz. vutbr. f eec. xzavod02. 

Projects Services Files 

3 - ® SNMPIMobilelP 

Source Packages 

ED- ̂  <default package > 

EpQtJ cz.vutbr,feec.xzavod02 

cz. vutbr, feec. xzavodO 2, resources 
1 f f l org 

ED ( j i Test Packages 

7 - ^ Libraries 

rii 
JDK 1,6 (Default) 

B - g Test Libraries 

SNMP4JLibrary -snmp4i-L, 11.2.jar 

Obr. 4.1: Import knihovny do prostředí NetBeans 

4.3.1 SNMP4MobileIP.java 

Pro běh programu v jazyce JAVA, je potřeba aby některá ze tříd obsahovala spusti­

telnou metodu main. To je právě případ třídy SNMP4MobileIP. java. Ta navíc dědí 

ze třídy JFrame, čímž vytváří základní viditelnou pracovní plochu programu - okno, 

znázorněné na obrázku 4.2. 

V horní části okna se nachází menu vytvořené z JMenuBar obsahující položky File, 

Tools a Help. Pod menu položkou File se skrývají standardně známé funkce jako 

Obr. 4.2: Základní okno programu 
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je Open, Save a Exit. Funkce Save slouží k uložení stavu a nastavení programu do 

X M L souboru tak jak je popsáno v kapitole 4.3.5. Položka Open pak slouží k ote­

vření takového souboru a načtení parametrů z něj. Poslední položkou v menu File 

je Exit, která ukončí běh programu. 

Druhá menu položka Tools obsahuje funkce Mobile node list (v iz 4.3.4) a 

SNMP probe(viz 4.3.6), blíže popsané v příslušných kapitolách. 

Pod panelem menu se nacházejí 2 tlačítka. První z nich přidává do bílé pracovní 

plochy JDesktopPane interní rámec JInternalFrame: 

JInternalFrame frame = createlFrame ( f r ); 

/ / v y t v o ř e n í instance rámce s~indexem fr 

jDesktopPanel . add ( frame ); 

/ / p ř i d á n í i n t e r n í h o rámce do p r a c o v n í plochy 

jDesktopPanel . getDesktopManager ( ) . activateFrame (frame ); 

/ / n a s t a v e n í i n t e r n í h o rámce jako a k t i v n í 

Důležitá je zde funkce createlFrame, která vrací novou instanci typu 

JInternalFrame, s názvem „Router + index". Dále nastaví vlastnosti rámce, aby jej 

bylo možné minimalizovat, maximalizovat, měnit jeho rozměry a zavírat. Následně 

je do rámce přidán panel RouterJPanel(viz 4.3.3) 

pr iva te javax . swing . JInternalFrame createlFrame ( in t index){ 

JInternalFrame iframe ; 

iframe = new JInternalFrame (" Router u"+index , true , true , true , true ); 

RouterJPanel panel = new Router JPanel (index ); 

r . s e tPane l (pane l ) ; 

r . se t InternalFrame( i f rame) ; 

iframe . add (pane l ) ; 

i f rame.grabFocus( ) ; 

fr++; 

return iframe ; 

} 
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Druhé tlačítko slouží k odebrání všech JInternalFrame z pracovní plochy: 

jDesktopPanel removeAll () ; / / o d s t r a n ě n í všech rámců 

jDesktopPanel repaint () ; / / p ř e k r e s l e n í prvku 

4.3.2 Request.java 

Třída Request. j ava představuje část programu, která se stará o odesílání a následné 

přijímání SNMP zpráv. Při vytvoření instance této třídy jsou jako výchozí hodnoty 

nastaveny tyto parametry: 

commtarget. setCommunity (new O c t e t S t r i n g ( " p u b l i c " ) ) ; 

/ /komuni ta pro o d e s í l á n í SNMP zpráv 

commtarget. se tVers ion (SnmpConstants . version2c ); / / ve r ze SNMP 

commtarget. se tRe t r i e s (0); / / p o č e t opakování 

commtarget. setTimeout (5000); / / t imeout zprávy 

Pokud by bylo potřeba tyto hodnoty změnit, tak lze k objektu commtarget 

přistupovat i z venku třídy Request. java a nastavit tak libovolné parametry doda­

tečně. O odeslání SNMP zprávy se stará veřejná funkce send, která má tři vstupní 

proměnné: 

• cílová IP adresa typu String 

• dotazované P D U typu PDU 

• boolean hodnota určující, zda odpověď bude ve formátu „OID = odpověď" 

nebo pouze „odpověď". 

Deklarace metody send: 

publ ic void send ( S t r i n g ipAddress , PDU pdu, boolean on ly .da ta ) throws 

Exception 

Po zavolání této metody se nastaví cílová adresa v objektu commtarget a začne 

se naslouchat na výchozím portu pro příchozí UDP datagramy: 

commtarget. set Address (new UdpAddress ( ipAddress + " / " + p o r t ) ) ; 

TransportMapping t ransport = new DefaultUdpTransportMapping () ; 

t ransport . l i s t e n () ; 
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Dále se vytvoří instance objektu SNMP, které se předá mapování portů, podle 

typu P D U 1 se použije metoda get pro získání požadované hodnoty:  

Snmp snmp = new Snmp( t ransport ); 

ResponseEvent response; 

i f (pdu. getType () = pdu.GETBULK) { 

response = snmp. getBulk (pdu , commtarget); 

}else i f . . . / / v í c e v p ř í l o z e 

. . . else response=null ; 

4.3.3 RouterJPanel.java 

Tato funkce, která dědí ze štandartní třídy Jpanel, tvoří srdce celé aplikace. Pro 

každý směrovač, který chceme sledovat si vytvoříme jednu instanci této třídy a ta 

nám bude daný směrovač sledovat a výsledky z něj získané zobrazovat na svých 

jednotlivých prvcích. Vzhled a rozmístění jednotlivých prvků je znázorněno na obr. 

4.3. 

Hlavním ovládacím prvkem je zde JButton s ikonou směrovače. Toto tlačítko stří-

._ . Router l 

SNMP settings 

FA1 
10.0.1.3 

No. interfaces: 8 

ifTable HA mobility bindings FA Visitors 

MN-host COA 

192.168.101.10 1172.16.2.1 

SourceAddress TirneGranted TimeRemaining 

1172.16.2.1 Il60 Ill2 

Obr. 4.3: Rozložení jednotlivých prvků na RouterJPanelu 

davě zapíná a vypíná odesílání SNMP dotazů na IP adresu uvedenou v JTextField. 

Pokud je odesílání aktivní, tak se textové pole deaktivuje, aby nebylo možné IP 
x z argumentu funkce send 
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adresu nedopatřením změnit. Barva rámečku okolo tlačítka indikuje, zda je daný 

IP uzel dosažitelný (zelená) či nikoliv(červená). To zdaje daný uzel „Online" zjistí 

funkce isOnline pomocí třídy InetAddress z balíčku java.net.*: 

pr iva te boolean i sOn l ine () { 

try { 
adresa = InetAddress . getByName ( th i s . getIP ( ) ) ; 

i f ( adresa . isReachable (2000)) { 

return t rue; / /pokud je dos tupný do 2000ms v r a c í true 

} else return f a l s e ; / / j i n a k v r a c í false 

} / / . . . n á s l e d u j e o š e t ř e n í výjimky 

Pokud je uzel dostupný následují tyto kroky: 

1. Barva ikony směr ovace se nastaví na zelenou 

RouterBtn . se tBackground(Color .g reen) ; 

2. Pomocí funkce getHostnameQ se zjistí název uzlu, který se napíše vedle ikony 

publ ic Request req = new Request() ; 

PDU hostnamePDU = new PDU(); 

hostnamePDU. setType (PDU.GET); 

hostnamePDU. add (new V a r i a b l e B i n d i n g (new OID (" 1 . 3 . 6 . 1 . 2 . 1 . 1 . 5 . 0 " ))) 

req . clearResponse_text () ; / / v y č i š t ě n í odpovědi od minulého dotazu 

req . send ( getIP () , hostnamePDU, true ) ; / / o d e s l á n í dotazu 

hostname = req . response _t ext . ge t F i r st ( ) ; / / z j i š t ě n í odpovědi 

RouterBtn . setText (hostname ) ; / / z o b r a z e n í odpovědi vedle t l a č í t k a 

3. Než se začnou ze síťového prvku získávat informace pro Mobile IP, je zapo­

třebí pomocí funkce checkMIPEntitiesQ zjistit, které entity protokolu Mobile 

IP jsou na daném uzlu v provozu. Program se dotazuje na objekt s názvem 

mipEntities. Vrácená hodnota udává bitově, které entity jsou aktivovány: bit 0 

pro mobilní uzel, bit 1 pro cizího agenta a bit 2 pro domovského agenta. Např. 

tedy pokud je aktivován domovský i cizí agent tak je vrácená hodnota 0x60, 

binárně 011000002. 

4. Funkce getlfTableQ nejdříve zjistí celkový počet rozhraní na zařízení a ná­

sledně získá tabulku parametrů těchto rozhraní. Zjišťují se hodnoty indexu 
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rozhraní(iflndex), popis rozhraní(ifDescr), přijaté(ifln) a odeslané(ifOut) bajty 

na rozhraní. Zdrojový kód této funkce je již poměrně dlouhý, a proto je uveden 

v příloze. 

5. Pokud se v kroku 3 zjistilo, že zařízení poskytuje služby domovského agenta, 

program zjistí pomocí funkce getHATableQ počet vazeb s mobilními uzly a 

následně zjistí jednotlivé hodnoty jako jsou domácí IP adresa mobilního uzlu, 

CoA, zdrojovou adrese, čas v sekundách který přiděluje při každé registraci 

mobilního uzlu a zbývající čas v sekundách. Pokud mobilní uzel neprovede 

reregistraci do vypršení času, je mobilní vazba zrušena. 

6. Podobně jako v předchozím kroku se zjišťují služby cizího agenta(pokud se 

v bodě 3 zjistilo, že tyto služby jsou poskytovány). Nejdříve se zjistí počet 

návštěvníků a následně se pro všechny zjistí parametry: návštěvníkova IP ad­

resa, jeho domácí adresa, adresa domácího agenta, u kterého je registrovaný, 

a časy jako v minulém případě. 

7. Tento postup se opakuje každých 5 sekund, dokud není uživatelem zastaven, 

nebo uzel nepřestane odpovídat (signalizováno červeně). 

Ve shrnutí se program chová tak(pokud je cílené zařízení dostupné), že tabulka 

rozhraní se zobrazí vždy i na zařízeních, které Mobile IP vůbec nepodporují. Po­

kud Mobile IP podporují, tak se dynamicky přidávají a odebírají tabulky mobilních 

vazeb návštěvníků. Přidávání a odebírání těchto tabulek pracuje podle algoritmu 

znázorněného na obrázku 4.4: 

Navíc je vidět, že při vytvoření mobilní vazby, se v tabulce rozhraní vytváří nové 

virtuální rozhraní - tunel. Ten se pro každého účastníka vytváří zvlášť tak jak se 

teoreticky předpokládá. Rozhraní tohoto tunelu se vytváří i v případě cizího agenta. 

Z pozorování počtu odeslaných bytů, bylo potvrzeno, že v případě kdy je M N zare­

gistrovaný u některého z FA dochází k trojúhelníkovému směrování, protože počet 

bytů narůstal pouze v jednom směru. U H A v odchozím směru a u FA v příchozím 

směru. V opačných směrech byly počty nulové. Pokud se ale M N registroval pro­

střednictvím CCoA, tak tunelování provozu probíhalo oběma směry. Tento stav je 

zobrazen na obrázku 4.5 
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Zjišťuje se index tabulky v 

kontejneru typu r 

JTabbedPane Pokud i=-1 
tak tabulka není součásti 
JTabbedPane 

i = indexOfTab 

Vytvoř a vlož tabulku 

A g ) í ' 

Obr. 4.4: Algoritmus udržování tabulky mobilních vazeb 

4.3.4 Zobrazení seznamu mobilních hostů 

Pokud sledujeme větší síť, kde je více než jeden domovský agent, a potřebujeme zjis­

tit, kde se daný mobilní uzel nachází. Je velice nepohodlné, hledat ke kterému domov­

skému agentovi je přiřazen a pak jej hledat v seznamu vazeb. Mnohem lepší se jeví 

způsob, kdy do společného seznamu mobilních uživatelů přispívají jednotliví domov­

ští agenti. Proto se během funkce getHAtableQ v třídě RouterJPanel. java(4.3.3) 

kontroluje, zda již daná mobilní vazba v globálním seznamu existuje, je potřeba j i 

modifikovat, nebo smazat. Globální seznam má strukturu LinkedList, a je součástí 

třídy SNMP4MobileIP.HaMobilityBindings. Způsob udržování seznamu je nazna­

čen v tomto úryvku kódu: 
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Obr. 4.5: Počet přijatých bajtů v jednotlivých tunelech 

H a M o b i l i t y B i n d i n g h = new H a M o b i l i t y B i n d i n g () ; 

h . setHaHostname (hostname ); 

. . . / / n a s t a v e n í hodnot z ~ p ř i j a t ý c h dat do objektu h 

h . se tHaMobi l i tyBindingTimeRemaining ( d a t a [ j ] [ 4 ] ) ; 

L inkedLi s t <HaMobi l i tyBinding> haBindings ; \ \ u k a z a t e l na glob . seznam 

haBindings = SNMP4MobileIP . HaMobi l i t yB ind ings ; 

boolean containsMN = false ; / / p ř e d p o k l á d á se, že MN není v~seznamu 

int 1 = 0 ; / / p o k u d ano tak do proměnné 1 se u l o ž í jeho index 

for ( in t k~= 0; k~< haBindings . s ize (); k++) { 

i f (haBindings . get (k ). ge tHaMobi l i tyBindingMN () . hashCode () = 

h . ge tHaMobi l i tyBindingMN () . hashCode ()) { / / p o r o v n á n í hashe 

containsMN = t rue ; / / pokud jsou s t e j n é tak MN je v~seznamu 

1 = k ; } } / / n a s t a v e n í hodnoty 1 na index v~seznamu 

i f (! containsMN) {//pokud MN není v~seznamu 

haBindings . a d d ( h ) ; / / p ř i d á se do seznamu 

}else i f ( con ta insMN){ / / j i nak pokud je v~seznamu 

haBindings . get (1 ). set . . . } / / v š e c h n y hodnoty se a k t u a l i z u j í 

Zobrazení seznamu mobilních uzlů proběhne na samostatném okně vyvolaného 

z menu Tools > Mobile node list. Po stisku tlačítka „Zobrazit" se naplní tabulka 

hodnotami z globálního seznamu SNMP4MobileIP.HaMobilityBindings Systém pl-
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lid m 
File Took Help 

Přidat router Qdebrat routery 

l£) Router 0 

SNMP settings [\, 

10.0 

No. ir 

jfTable mobility bindii 

Home agent 
HA 

MN-host 
192.16S.100.lfl COA 

172. IE. 1.1 
192.168.101.10 
192.16S.100.il 

Foreign agent 
FA 1 

Error: žádná SNM.. 

TimeGranted 
150 

TlmeRernaining 
85 

MN-host COA 
192.168.100.10 1172.16. 

TlmeRernaining 
|83  

Lid Router2 

SNMP settings 

10 

No. inteTTl 

«Table FA Visitors 

VisitorlPAddr... HomeAddress HomeAgentA.. 
192.168.101.10 |l92,168,101,lD |lfl.0.1.3 

TimeGranted 
160 

TlmeRernaining 
|115  

Obr. 4.6: Okno seznamu mobilních uzlů 

není je obdobný jako ve třídě RouterJPanel. java, pouze s tím rozdílem, že na 

adresu CoA se zašle SNMP dotaz na parametr sysName, což odpovídá hostname 

uzlu cizího agenta. Z obrázku 4.6 je vidět, že v prvních dvou řádcích došlo k úspěš­

nému zjištění názvu cizího agenta, ale v posledním se nepodařilo hostname zjistit, 

protože mobilní uzel 192.168.100.11 je registrován prostřednictvím CCoA, tudíž 

by musel na SNMP dotaz odpovědět sám. 

4.3.5 Ukládání nastavení do X M L souborů 

Uložení nastavení do souboru se mohlo provézt i prostým uložením do obyčejného 

textového souboru. To ale neposkytuje takovou přehlednost zápisu jako je to v pří­

padě X M L souboru. Extensible Markup Language (XML) je obecně známý znač­

kovací jazyk. Byl vyvinut konsorciem W3C[8] pro univerzální výměnu dat mezi 

aplikacemi. Nestará se o vzhled(styl) dat, ale pouze o jejich datovou strukturu. Pro 

zpracování X M L souborů, lze obecně i v jazyce JAVA využít dvou přístupů: 
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• Document Object Model (DOM) parser - data se načtou a z nich se vytvoří 

stromová struktura představující původní dokument. Je jednodušší na imple­

mentaci, ale při velkých souborech spotřebovává velké systémové požadavky. 

• The Simple A P I for X M L (SAX) parser - tak jak jsou data postupně načítána, 

parser generuje postupně sérii událostí. Je složitější na implementaci. Své vý­

hody využívá při zpracování velkých souborů, protože nemusí být celé načtené 

do paměti. 

Protože budu zpracovávat pouze malé soubory, rozhodl jsem se v práci využít 

D O M parseru. Základem každého X M L dokumentu je kořenová entita(root) obsa­

hující další otagované elementy. Příklad vytvořeného X M L souboru: 

<?xml version=" 1.0" encoding="UTF—8" standalone="no" ?> 

< R o u t e r s > / / k o ř e n dokumentu 

<Router id=" ()">// p rvn í RouterJPanel s~id 0 

<IP>10.0.0.3</IP> / / I P adresa 

<frameBounds>//vlastnost i okna 

<x>15</x> / / p o z i c e ve směru x 

<y>20</y> / / p o z i c e ve směru y 

<width>453</width> / / š í ř k a okna 

<height >298</height> / / v ý š k a okna 

</frameBounds> 

</Router> 

< / R o u t e r s > / / u k o n č e n í dokumentu 

Pro vytváření těchto souborů byla vytvořena třída XMLCreator. java. Pro ulo­

žení do X M L souboru slouží funkce saveAs, které předáme pomocí argumentů se­

znam RouterJPanelů s parametry a odkaz na soubor do kterého budeme hodnoty 

zapisovat.  

publ ic void saveAs (L inkedLi s t <RouterData> l i s tOfRoute r s , F i l e f i l e ) 

Funkce vytvoří novou instanci dokumentu, kořen dokumentu nazve „Routers". 

Se seznamu listOfRouters postupně získává data a vytváří z nich elementy. Příklad 

vytvoření zjednodušené struktury dokumentu je zobrazen na následujícím kódu: 
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DocumentBuilderFactory docFactory=DocumentBuilderFactory . newlnstance () ; 

DocumentBuilder docBui lder = docFactory . newDocumentBuilder () ; 

Document doc = docBui lder . newDocument (); 

Element rootElement = doc . createElement (" Routers" ); 

doc . appendChild ( rootElement) ; 

Element router = doc . createElement (" Router" ); 

rootElement . appendChild ( router ); 

rou te r . s e t A t t r i b u t e ( " i d " , I n t e g e r . t o S t r i n g ( j ) ) ; 

Opačný účel jako funkce saveAs má metoda Open. 

publ ic L i n k e d L i s t Open ( F i 1 e f i l e ) 

Ze zvoleného souboru file, za pomocí D O M parseru, sestaví seznam oken 

Router JPanel-ů a nadřazená třída SNMP4MobileIP(4.3.1) si z něj sestaví okna s roz­

místěním tak jak tomu bylo při jeho uložení. Podrobný zdrojový kód je uveden 

v příloze A . 

4.3.6 SNMP probe - testování funkčnosti SNMP 

Protože je v určitých případech nutno ověřit správnou funkci SNMP protokolu, byla 

sestavena funkce pro ověření správnosti. Tato funkce se skrývá ve třídě 

SNMPProbeJDialog. java. Jak název napovídá, jedná se o dialogové okno JDialog, 

které lze zobrazit v menu Tools > SNMP probe. Ve výchozím nastavení je nastavení 

jsou nastaveny hodnoty podle tabulky 4.1. Pokud je SNMP agent správně nastaven 

a je dostupný, tak se po stisknutí tlačítka Send zjistí objekt s OID 1.3.6.1.2.1.1.5.0 

neboli sysName ve tvaru OID = hodnota. Pokud nastane výjimka, agent vrátí index 

této výjimky viz tabulka 2.2. 

4.3.7 Analýza komunikace aplikace 

V předešlých kapitolách bylo nastíněno funkční jádro celé aplikace. Za velmi důležité 

považuji i znázornit jak se aplikace chová „navenek". 
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Tab. 4.1: Výchozí hodnoty SNMP probe 

Název hodnoty Hodnota 

Community public 

SNMP verze 2c 

Počet opakovaných pokusů 5 

Timeout zprávy 2000ms 

U D P Port 161 

Typ SNMP zprávy G E T 

IP adresa 10.0.0.3 

OID 1.3.6.1.2.1.1.5.0 

Pro zachycení komunikace, lze využít libovolného síťového analyzátoru. K těm nej-

známějším a nej dostupnějším patří analyzátor Wireshark. Z komunikace je velice 

zřejmé jak SNMP protokol funguje. SNMP manager nejdřív vyšle SNMP dotaz 

např. getBulkRequest na cílový UDP port 161 s náhodně zvolenou hodnotou zdro­

jového portu např. 52280. SNMP agent po obdržení dotazu porovná, zda se řetězec 

community shoduje s jeho nastaveným řetězcem. Pokud ano odpovídá z portu 161 na 

port, ze kterého došel dotaz. Při dalším dotazu SNMP manager hodnotu zdrojového 

portu inkrementuje o 1. Obrázek 4.7 zobrazuje zachycenou komunikaci, konkrétně 

odpovědna dotaz getBulkRequest. Z analýzy vyplývá, že je mnohem ekonomičtější 

používat zprávy typu Bulk, protože všech 32 hodnot, se přeneslo v jediném paketu. 

Bohužel, jak jsem se přesvědčil, tyto zprávy nemají zařízení všech firem správně 

implementovány. Např. A D S L směrovač firmy D-Link s označením DSL-584T místo 

aby vrátil pouze dotazované objekty z MIB tabulky i f Table, vrátil první 4 objekty 

této tabulky. 

Dále je zřejmé, že komunikace probíhá nešifrovaně. To je způsobenou použitím 

SNMPv2c. V praxi by bylo nutné přejít na SNMPv3, aby komunikace nemohla 

být při analýze takto snadno čitelná. Na druhou stranu, tato jednoduchá čitelnost 

napomáhala při vývoji aplikace, pro kontrolu správnosti odesílaných a přijímaných 

dat. 
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• Simple Network Management Protocol 

vers ion : v2c (1) 
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• data: get-response (2) 
3 get-response 

request - id : 1238320668 
e r r o r - s t a t u s : noError (0) 
error- index: 0 

• var iab le-b ind ings : 32 items 

ef:2e (00:24:81:3a:ef:2e) 
1-3) 

E I F -MI E: : i f i n d e x . 1 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 1 ) : 1 
E : F -Hl E: : i f D e s c r . l (1. 3.6.1. 2.1. 2. 2 .1 .2 .1) : FastEthernetO/0 
E : F -Hl B: : i f l n D c t e t s . l ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 0 . 1 ) : 1702601 
E : F -MI E: Mfoutoctets . 1 ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 . 1 ) : 2768596 
E : F -HI B: : i f l n d e x . 2 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 2 ) : 2 
E : F -Hl B: : i fDescr .2 (1. 3.6.1. 2.1. 2. 2.1.2.2) : FastEthernetO/1 
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E : F -MI B: : i f o e s c r . 3 (1. 3.6.1. 2.1. 2. 2.1.2. 3) : FastEthernetO/0/0 
E : F -Hl B: : i f i n o c t e t s . 3 (1. 3 .6 .1 .2 .1 .2 .2 .1 .10. 3): 0 
E : F -Hl B: : i f O u t a c t e t s .E ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 . 3 ) : 0 
E : F -Hl B: : i f index. 4 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 4 ) : 4 
E : F -Hl B: : i fDescr .4 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 2 . 4 ) : SSLVPN-VIFO 
E : F -Hl B: : i f i n o c t e t s . 4 (1. 3 .6 .1 .2 .1 .2 .2 .1 .10 .4 ) : 0 
E : F -Hl B: : i f o u t o c t e t s . 4 ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 . 4 ) : 0 
E : F -Hl B: Mfindex. 5 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 5 ) : 5 
E : F -HI B: : i fDescr .5 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 2 . 5 ) : NullO 
E : F -Hl B: : i f i n o c t e t s . 5 (1. 3. 6. 1. 2 .1.2.2.1.10.5) : Q 
E : F -MI B: Mfoutactets . 5 ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 . 5 ) : 0 
E : F -Hl B: : i f l n d e x . 6 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 6 ) : 6 
E : F -Hl B: : i fDescr .G (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 2 . 6 ) : MobileO 
E : F -MI B: : i f i n o c t e t s . 6 (1. 3. 6. 1. 2 .1 .2 .2 .1 .10 .6) : 0 
E : F -Hl B: Mfoutoctets . f (1. 3 .6 .1 .2 .1 . 2. 2.1.16. 6) : 0 
E : F -Hl B: : i f l n d e x . 8 (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 . 6 ) : 8 
E : F -Hl B: : i fDescr .R (1. 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 2 . 6 ) : Tunnell 
E : F -Hl B: M f i n o c t e t s . 8 ( 1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 0 . 8 ) : 52221 
1+1 I F -MI B: : i f O u t a c t e t s . £ Q . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 . B I : 15736 

O File: T:\andra\DokumentyVVUT\_diplomk... Packets: 285 Displayed: 67 Marked: 0 I Profile: Default 

Obr. 4.7: Analýza komunikace programu 

4.4 Návod k použití aplikace 

Aplikace je zkompilována do jediného souboru s příponou .jar a je obsažena na 

přiloženém disku viz příloha A . Spustit j i lze v prostředí Windows příkazem 

java -jar SNMP4MobileIP.jar 

Po spuštění se zobrazí okno zobrazené na obrázku 4.2. Pokud začínáme sledovat no­

vou síť, přidáváme pomocí tlačítka „Přidat router" zařízení, která budeme sledovat. 

V pracovním prostoru se zobrazí „podokno" zobrazené na obrázku 4.3. Do textového 

panelu vložíme IP adresu uzlu a pomocí tlačítka se aktivuje sledování tohoto uzlu. 
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Ve výchozím nastavení se každých pět sekund zasílají SNMP dotazy na daný uzel. 

Nejprve se zjišťuje hostname uzlu, který se zapíše vedle ikony směrovače, dále se zjistí 

tabulka rozhraní, která obsahuje jejich indexy, názvy a počty přijatých a odeslaných 

bajtů na jednotlivých rozhraních. Dále se zjistí, které entity protokolu Mobile IP 

jsou na uzlu aktivní. Pokud jsou aktivní služby domovského agenta, přidá se vedle 

tabulky s rozhraními tabulka s navázanými vazbami s mobilními uzly. Obdobně se 

zobrazí tabulka v případě cizího agenta, s tím, že se zobrazuje seznam návštěvníků. 

Celá aplikace vypadá tak jak je ukázáno na obrázku 4.8. Na obrázku jsou vidět zare-

I ° I e I a" 
File Tools Help 

Přidat router Odebrat routery 

l£J Router 0 

SNMP settings 

No, interfaces: 8 

ifTable HA mobility bindings 

MN-host COA 
19Z. 168.100.10 I172.1S.11 

SourceAddress TirneGranted TlmeRemaining 
Il72.lfi.il 150 1131 

192.lS8.lD0.il 145.225.1.4 145.229.1.4 150 

No. interfaces: 

ifTable HA mobility bindings FA Visitors 

MN-host COA SourceAddress TirneGranted TlmeRemaining 
192.168.101.111 1172.16.2.1 |l72.1S.2.1 160 |112 

LU Router 2 

SNMP settings 

No. interfaces: 6 

ifTable FA Visitors 

VisitorlPAddr... HomeAddress HomeAgentA... TirneGranted TlmeRemaining 
192,168.101.10 Il92.168.101.10 |l0,0,l,3 [l60 [lM 

Obr. 4.8: Zobrazení celé aplikace 

gistrované mobilní uzly - 2 u směrovače s názvem H A a 1 dodatečně u F A l . Seznam 

všech mobilních uzlů je možné zobrazit z menu Tools > Mobile node l i s t tak jak 

je vidět na obrázku 4.6. SNMP nastavení je možné upravit pro jednotlivé uzly v 

menu SNMP settings Rozmístění oken, včetně se zadanými adresami, lze uložit po­

mocí menu File > Save do X M L souboru. To umožní, při dalším spuštění aplikace 

pomocí menu File > Open tento soubor otevřít a nastavení aplikovat do aplikace. 

44 

http://I172.1S.11
http://Il72.lfi.il
http://192.lS8.lD0.il
http://Il92.168.101.10


5 ZÁVĚR 

Během této práce jsem se podrobně seznámil s protokoly Mobile IP a SNMP. Proble­

matiku protokolu MIP jsem nastínil v kapitole 1. V průběhu práce jsem si uvědomil 

potenciál tohoto protokolu a zároveň mě mrzí, že tento protokol se příliš neuchytil 

co se týče IPv4. Vypadá to, že pro tuto verzi již protokol velké uplatnění nena­

jde. Do budoucna se má ale šanci uchytit se zaváděním IPv6, což bude ale ještě 

předmětem mnohých výzkumů a vývojů technologií. 

V další části práce jsem teoreticky rozebral podstatu protokolu SNMP. Ten velmi 

dobře plní funkci prostředníka při vzdáleném spravování síťových prvků. Třetí ka­

pitola popisuje testovací síť tvořenou výkonnými aktivními prvky od firmy Cisco 

modelové série 1841. Jako mobilní uzel byl použit stolní počítač s operačním systé­

mem Windows X P a programem Cisco Mobile Client verze 2.0.14. Funkčnost celé 

sítě a protokolu Mobile IP byla otestována a případné problémy pomocí debugu na 

konzoli IOS odstraněny. V poslední kapitole popsán vývoj aplikace v jazyce JAVA 

za pomocí A P I SNMP4J. Ta je schopná velice dobře a názorně zobrazit co se s prvky 

sítě děje. Nejdříve zjistí, zda je daný uzel sítě dostupný a následně na něj zasílá 

SNMP dotazy, ze kterých dostává potřebná data. Z dat pak zjistí např. hostname 

daného síťového uzlu nebo podporované služby protokolu Mobile IP. Tyto data pak 

podle typu vhodně zobrazí buď jen na panelu jedná-li se o jednoduché hodnoty. 

Jestliže jsou data tabulkového typu, je z nich potřebná tabulka sestavena a zobra­

zena. Program dokáže zobrazit celkem 3 různé tabulky: seznam síťových rozhraní 

s počty odeslaných a přijatých bajtů, seznam vazeb domovského agenta a seznam 

návštěvníků cizího agenta. Programu od počátku práce prodělal velké změny. V se­

mestrální práci byla prezentována aplikace, která zjišťovala jen zlomek toho co dělá 

nyní. Počáteční problém bylo pouze zaslat dotaz a přijmout odpověď. Jakmile bylo 

tohoto dosaženo, mohlo se pracovat na zasílání složitějších zpráv jako je GetBulk 

a sestavit z odpovědi tabulku. Bylo potřeba sestavit řadu pomocných funkcí, které 

umožnily přehlednější programování. Z doložených obrázků je vidět silný potenciál 

této aplikace při správě sítí s Mobile IP. Především přehlednost je znatelná, protože 

jediný jiný způsob jak zjistit zobrazená data(obr. 4.8) je se k jednotlivým zařízením 
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připojit pomocí konzole, telnetu nebo ssh a zadáváním příkazů požadovaná data 

zobrazit. 

Naprogramování v jazyce JAVA umožnilo, že je program objektově orientovaný a 

tudíž dobře čitelný. Díky tomu by bylo možné program dále vyvíjet za hranice zadání 

a různě zlepšovat, např. ukládat do databáze, kde se jaký mobilní uzel v daném čase 

nacházel apod. To už by byl ale asi námět na jinou diplomovou práci. 
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SEZNAM SYMBOLU, V E L l C l N A Z K R A T E K 

A P I Application Programming Interface 

H A Home agent 

FA Foreign agent 

M N Mobile node 

C N Correspondent node 

OSPF Open shortest path first 

CoA Care of Address 

CCoA Co-located Care of Address 

IS Internet solution 

IETF Internet Engineering Task Force 

MIP Mobile IP 

SNMP Simple Network Management Protocol 

SMI Structure of Management Information 

MIB Management Information Base 

OID Object Identifier 

IRDP ICMP Router Discovery Messages 

X M L Extensible Markup Language 

D O M Document Object Model 

S A X The Simple API for X M L 

A S N . l Abstract Syntax Notation One 

B E R Basic Encoding Rules 
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V L A N Virtual Local Area Network 

OSI Open Systems Interconnection 

SPI Security Parametr Index 

NAI Network Access Identifier 

RADIUS Remote Authentication Dial In User Service 
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A OBSAH PŘILOŽENÉHO DISKU 

A . l Výpis obsahu disku 

\ root 

\animace / / f l a s h o v á animace z o b r a z u j í c í 

prezentace.htm / / h t m l s t r á n k a pro s h l é d n u t í animace 

prezentace . swf //macromedia f lash 

\ c i s c o / / k o n f i g u r a č n í soubory pro Cisco z a ř í z e n í 

\ d i s t / / s l o ž k a se zkompilovaným programem 

\ 1 i b / / kn ihovny p o t ř e b n é pro běh programu 

SNMP4MobileIP . j ar / / s a m o t n ý program 

spustme.bat / / s p o u š t ě c í soubor programu pro p r o s t ř e d í Windows 

\mibs / / v y u ž í v a n é ME5 

\NetBeans projekt 

SNMP4MobileIP.zip / / z a b a l e n ý projekt pro NetBeans 

/ / se zdrojovými kódy 

s n m p 4 j - 1 . 1 1 . 2 - d i s t r i b u t i o n . z i p / / p o u ž i t é API SNMP4J 

xzavod02_DP.pdf / / t e n t o text v e l e k t r o n i c k é podobě 

51 

file:///animace
file:///cisco
file:///dist
file:///mibs
file:///NetBeans


B KONFIGURAČNÍ SOUBORY SMĚROVAČŮ 

B . l Home agent 
i 

version 12.4 

no service password-encryption 
! 

hostname HA 
i 

interface FastEthernetO/0 

ip address 10.0.0.3 255.255.255.0 

duplex auto 

speed auto 

! 
interface FastEthernetO/1 

ip address 192.168.0.1 255.255.255.0 

ip mobile foreign-service 

ip irdp 

ip irdp maxadvertinterval 4 

ip irdp minadvertinterval 4 

ip irdp holdtime 9 

duplex auto 

speed auto 

! 
interface FastEthernetO/0/0 

no ip address 

shutdown 

duplex auto 

speed auto 

! 
router mobile 
i 

router ospf 1 

redistribute mobile subnets 

network 10.0.0.0 0.0.0.255 area 0 

network 192.168.0.0 0.0.255.255 area 0 
i 

ip mobile home-agent 

ip mobile virtual-network 192.168.100.0 255.255.255.0 

ip mobile host 192.168.100.10 192.168.100.20 virtual-network 192.168.100.0 255.255.255.0 

lifetime 100 

ip mobile foreign-agent care-of FastEthernetO/1 

ip mobile secure host 192.168.100.10 spi 100 key hex 1234567890abcdef1234567890abcdef 

algorithm hmac-md5 

ip mobile secure host 192.168.100.11 spi 100 key hex 1234567890abcdef1234567890abcdef 

algorithm hmac-md5 

! 
banner motd "Home Agent, xzavod02Sstud.feec.vutbr.cz" 
! 

snmp-server community public RO 
! 

control-plane 
! 

line con 0 

logging synchronous 

line aux 0 

line vty 0 4 

privilege level 15 

no login 

! 
end 
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B.2 Foreign agenti 
version 12.4 
i 

hostname FA1 
! 

interface FastEthernetO/0 

ip address 10.0.x.3 255.255.255.0 

duplex auto 

speed auto 

! 
interface FastEthernetO/l 

ip address 172.16.x.1 255.255.255.0 

ip mobile foreign-service 

ip irdp 

ip irdp maxadvertinterval 4 

ip irdp minadvertinterval 3 

ip irdp holdtime 9 

duplex auto 

speed auto 

! 
router mobile 
! 

router ospf 1 

redistribute mobile 

passive-interface FastEthernetO/1 

network lO.O.x.O 0.0.0.255 area 0 

network 172.16.X.0 0.0.0.255 area 0 
! 
ip mobile foreign-agent care-of FastEthernetO/l 

ip mobile foreign-service 
! 
snmp-server community public RO 
! 

line con 0 

logging synchronous 

line aux 0 

line vty 0 4 

privilege level 15 

no login 
! 

end 

B.3 Internet solution 
! 

version 12.4 

hostname IS 
! 

no ip domain lookup 
! 

interface FastEthernetO/0 

ip address 145.229.1.1 255.255.255.0 
! 

interface FastEthernetO/l 

ip address 192.168.1.2 255.255.255.0 

! 
interface FastEthernet0/0/0 

switchport access vlan 10 

! 
interface FastEthernet0/0/l 

switchport access vlan 11 
! 

interface FastEthernetO/0/2 

switchport access vlan 12 

! 
interface FastEthernetO/0/3 



interface Vlanl 

no ip address 

! 
interface VlanlO 

ip address 10.0.0.1 255.255.255.0 
1 

interface Vlanll 

ip address 10.0.1.1 255.255.255.0 
1 

interface Vlanl2 

ip address 10.0.2.1 255.255.255.0 
1 

router ospf 1 

passive-interface FastEthernetO/0 

network 10.0.0.0 0.0.255.255 area 0 

network 145.229.1.0 0.0.0.255 area 0 
i 

banner motd "Internet Solution, xzavod02Sstud.feec.vutbr.cz" 
! 

line con 0 

logging synchronous 

line aux 0 

line vty 0 4 

privilege level 15 

no login 

! 
scheduler allocate 20000 1000 

end 

B.4 Switch 
interface FastEthernetO/1 

decription to HA 

switchport access vlan 1 

switchport mode access 

spanning-tree portfast 

! 
interface FastEthernet0/2 

decription to FA2 

switchport access vlan 2 

switchport mode access 

spanning-tree portfast 

! 
interface FastEthernetO/3 

decription to FA1 

switchport access vlan 3 

switchport mode access 

spanning-tree portfast 

! 
interface FastEthernetO/4 

decription to Mobile node 

switchport access vlan x 

switchport mode access 

spanning-tree portfast 

B.5 Mobile node 
výpis konfiguračního souboru xzavod02.mcprofile 

#CiscoSystems 

Version = 11.0 

profile 

profile-header 

id = xzavod02 

key-version = 2.3 
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ack-id = 0 

disable-protection = false 

device-mode = false 

end-prof ile-header 

mobile-ip 

local-ip-address = 192.168.100.10 

local-subnet = 255.255.255.0 

local-default-gateway = 192.168.100.1 

passthru = false 

broadcast-on = false 

broadcast-on-ppp = false 

enable-dynamic-ha = false 

initial-re-registration-time = 4 

re-registration-minimal-time = 30 

re-registration-threshold = 90 

colocated-registration-time = 600 

AAA-authenticate-always = false 

wait-colocated-time = 2 

force-reverse-tunneling = dont 

solicitation-address = 224.0.0.2 

registration-mode-classical 

home-agent-external-address = 10.0.0.3 

home-agent-internal-address = 10.0.0.3 

end-registration-mode-classical 

security-association 

remote-end = HA 

security-context 

spi = 0x100 

algorithm-identifier = HMAC-MD5 

key = 1234567890abcdefl234567890abcdef 

replay-protection-method = timestamp 

end-security-context 

end-security-association 

trusted-fa-list 

0.0.0.0 

end-trusted-fa-list 

end-mobile-ip 

end-profile 
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C SNMP APLIKACE 
Zdrojové kódy lze primárně nalézt na přiloženém disku, zde uvádím pouze jejich část. 

C l Request .java 

package c z . v u t b r . f e e c . x z a v o d 0 2 ; 

import j a v a . u t i l . L i n k e d L i s t ; 
import org . snmp4j . CommunityTarget; 
import org . snmp4j .PDU; 
import org . snmp4j . Snmp; 
import org . snmp4j . T ranspor tMapping ; 
import org . snmp4j . event . ResponseEvent ; 
import org . snmp4j .mp. SnmpConstants ; 
import org . snmp4j . s m i . O c t e t S t r i n g ; 
import org . snmp4j . s m i . UdpAddress ; 
import org . snmp4j . t r a n s p o r t . De fau l tUdpTranspor tMapp ing ; 

p u b l i c c l a s s Request{ 

p r i v a t e s t a t i c S t r i n g port = " 1 6 1 " ; 

p u b l i c s t a t i c S t r i n g g e t P o r t Q { 
r e tu rn port : 

} 
p u b l i c s t a t i c vo id s e t P o r t ( S t r i n g p o r t ) { 

Request . port = port : 
} 

p u b l i c L i n k e d L i s t < S t r i n g > response_ tex t = new L i n k e d L i s t <S t r i ng >(); 
p u b l i c L i n k e d L i s t < S t r i n g > o id = new L i n k e d L i s t <S t r ing >(); 
p u b l i c CommunityTarget commtarget = new CommunityTarget () ; 
p u b l i c v o i d MyRequest(){ 

commtarget . setCommunity (new O c t e t S t r i n g (" p u b l i c " )) ; 
commtarget . s e t V e r s i o n ( SnmpConstants . v e r s i o n 2 c ) ; 
commtarget . s e t R e t r i e s (0) ; 
commtarget . se tTimeout (5000) : 

} 
p u b l i c vo id c l e a r R e s p o n s e . t e x t () { 

i f (! r esponse_ tex t . i sEmpty ()) { 
r e s p o n s e . t e x t . c l e a r ( ) ; 
o id . c l e a r () : 
} 

} 
p u b l i c S t r i n g ge tResponse_text ( i n t arg) { 

r e tu rn r e s p o n s e . t e x t . g e t ( a r g ) : 
} 
p u b l i c i n t g e t R e s p o n s e . t e x t S i z e () { 

r e tu rn r e s p o n s e . t e x t . s i ze ( ) : 
} 

p u b l i c vo id send ( S t r i n g ipAddress , PDU pdu, boolean on ly_da ta ) throws E x c e p t i o n 
{ 

commtarget . set Addres s (new UdpAddress ( i p A d d r e s s + " / " + p o r t ) ) : 
Transpor tMapping t r a n s p o r t = new Defau l tUdpTranspor tMapp ing () ; 
t r a n s p o r t . l i s t e n () : 

Snmp snmp = new Snmp ( t r a n s p o r t ) : 

ResponseEvent response : 
i f ( p d u . g e t T y p e Q = pdu.GETBULK) { 

response = snmp . ge tBu lk (pdu , commtarget) ; 
}e l se i f ( p d u . g e t T y p e Q = pdu.GET) { 

response = snmp . get (pdu , commtarget) ; 
} e lse i f ( p d u . g e t T y p e Q = pdu .GETNEXT) { 

response = snmp . getNext (pdu , commtarget) ; 
}e l se i f ( p d u . g e t T y p e Q == pdu.SET){ 
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response = snmp . set (pdu , commtarget) ; 
} else r e sponse=nu l l ; 

i f ( response != n u l l ) { 
PDU responsePDU = response . getResponse () ; 

i f (responsePDU != n u l l ) 
{ 

in t e r r o r S t a t u s = responsePDU . g e t E r r o r S t a t u s ( ) ; 
S t r i n g e r r o r S t a t u s T e x t = responsePDU . g e t E r r o r S t a t u s T e x t () ; 

i f ( e r r o r S t a t u s = PDU. n o E r r o r ) { 
S t r i n g resp = n u l l ; 

for ( i n t i = 0; i < responsePDU. s iz e () ; i++) { 
i f ( on ly_da t a ) resp = responsePDU . get ( i ) . g e t V a r i a b l e ( ) . t o S t r i n g () ; 
i f ( ! o n l y _ d a t a ) resp = responsePDU . get ( i ) . t o S t r i n g () ; 
t h i s . r e s p o n s e . t e x t . a d d ( r e s p ) ; 
t h i s . o id . add (responsePDU . g e t ( i ) . g e t O i d ( ) . t o S t r i n g ()) : 
} 

} else 
{ 

t h i s . r e sponse_ tex t . add (" E r r o r : -Request - F a i l e d - " ); 
} 

} 
else 
{ 

t h i s . r e s p o n s e . t e x t . a d d ( " E r r o r : „ ž á d n á - S N M P - o d p o v ě ď " ) ; 

} 
} 
else 
{ 

t h i s . r e s p o n s e - t e x t . add ( " E r r o r : - Agent - Timeout . . . - " ) ; 

} 
snmp . c 1 o s e () ; 

} 
} 

C.2 Router J Panel. Java 
Zdrojový kód tohoto souboru je zde ve zkrácené verzi(celý obsahuje cca 750 řádků). 
Celý zdrojový kód je možné nalézt na přiloženém disku. 
package c z . v u t b r . f e e c . x z a v o d 0 2 ; 

p u b l i c c l a s s R o u t e r J P a n e l extends j a v a x . swing . J P a n e l { 
p u b l i c i n t i ; 
p u b l i c Request i c q = new Request ( ) ; 

PDU ifNumberPDU= new P D U ( ) ; 
PDU c m i H a R e g T o t a l M o b i l i t y B i n d i n g s = new P D U ( ) ; 
PDU c m i F a R e g T o t a l V i s i t o r s = new P D U ( ) ; 
PDU m i p E n t i t i e s = new P D U ( ) ; 
PDU hostnamePDU = new P D U Q ; 
PDU i f T a b l e P D U = new P D U ( ) ; 
PDU HATablePDU = new P D U Q ; 
PDU FATablePDU = new P D U Q ; 
S t r i n g hostname; 
CommunityTarget commTarget = new CommunityTarget () ; 
J D i a l o g S N M P S e t t i n g s s e t t i n g s ; 
S t r i n g ifcolumnNames [] = { " i f l n d e x " , " i f D e s c r " , " i f l n " , " i f O u t " } ; 
S t r i n g HAcolumnNames [ ] = {"MN-hos t " , "COA" , " TimeGranted" , " TimeRemaining" } ; 
S t r i n g FAcolumnNames [ ] = {" V i s i t o r l P A d d r e s s " , " HomeAddress" , " H A A d d r e s s " , 

"TimeGranted" , "T imeRemain ing"} ; 
EmptyJPanel i f J P a n e l , haJPanel , fa J P a n e l ; 
J S c r o l l P a n e i f J S c r o l l P a n e , h a J S c r o l l P a n e , f a J Scr o l l P ane ; 
JTab le i f J T a b l e , haJTable , f a J T a b l e ; 
s t a t i c Timer t imer = new Timer () ; 

57 



boolean homeAgent , fo re ignAgen t 

V a r i a b l e B i n d i n g i f T a b l e V B [ ] 
/ / I n t e r f a c e s 

new V a r i a b l e B i n d i n g (new 
new V a r i a b l e B i n d i n g (new 
new V a r i a b l e B i n d i n g (new 
new V a r i a b l e B i n d i n g (new 
} ; 

V a r i a b l e B i n d i n g HATableVB [ ] 
/ / I n t e r f a c e s 

new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 

} ; 
V a r i a b l e B i n d i n g FATableVB [ ] 

/ / I n t e r f a c e s 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 
new V a r i a b l e B i n d i n g (new OID(' 

} ; 

= { 

OID ( " 1 . 3 . 6 . 1 . 2 . 1 
OID ( " 1 . 3 . 6 . 1 . 2 . 1 
OID ( " 1 . 3 . 6 . 1 . 2 . 1 . 
OID ( " 1 . 3 . 6 . 1 . 2 . 1 . 

= { 

1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 
1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 
1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 
1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 
1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 

1.44.1 
1.44.1 
1.44.1 
1.44.1 
1.44.1 

6.3 
6.3 
6.3 
6.3 
6.3 

1 .1" )) , / / i f I n d e x 
1.2" )) . / / i f D e s c r 
1.10" )) . / / i f l n B y t e s 
1 .16" ) ) / / i f O u t B y t e s 

1 . 1 . 1 " ) ) , / / h a M o b i l i t y B i n d i n g M N 
1 . 1 . 2 " ) ) , / /haMobBindingCOA 
1 . 1 . 3 " ) ) , / / S o u r c e A d d r e s s 
1 . 1 . 7 " ) ) , / / T i m e G r a n t e d 
1 . 1 . 8 " ) ) / / TimeRemaining 

1.1 
1.1 
1.1 
1.1 
1.1 

1 " )) , / / f a V i s i t o r I P A d d r e s s 
2 " )) , / / fa V i s i t o rHomeAddres 
3 " )) 11 /HomeAgent Address 
1 " )) , / / T i m e G r a n t e d 
'> " )) 11 /T imeRemain ing 

1 . 3 . 6 . 1 . 2 . 1 . 2 . 2 . 1 . 1 6 " ) ) / / i f O u t B y t e s 

p u b l i c boolean loop_enabled 
p r i v a t e Ine tAddress adresa = 
/ / I n t e r f a c e B y t e s g ra f ; 
p u b l i c i n t i n t e r v a l = 5 0 0 0 : 

= f a l s e ; / / n a z a č á t k u je o p a k o v á n í vypnuto 
n u l l ; 

p u b l i c R o u t e r J P a n e l ( i n t index) { 
in i tComponen t s ( ) ; 
i = i n d e x ; 

homeAgent = fa l se ; 
fo re ignAgen t = f a l s e ; 

i p A d d r j T e x t F i e l d . se tTex t (SNMP4MobileIP . Routers . get ( i ) . get IP () ) ; 

ifNumberPDU . setType (PDU.GET) ; 
ifNumberPDU.add(new V a r i a b l e B i n d i n g (new OID(" 1 . 3 . 6 . 1 . 2 . 1 . 2 . 1 . 0 " ) ) ) ; 
i f T a b l e P D U . setType (PDU.GETBULK) ; 
i f T a b l e P D U . a d d A l l ( i f T a b l e V B ) ; 

HATablePDU . se tType (PDU.GETBULK); 
HATablePDU . a d d A l l (HATableVB ) ; 

FATablePDU . setType (PDU.GETBULK); 
FATablePDU . a d d A l l (FATableVB ) ; 

m i p E n t i t i e s . setType (PDU.GET) ; 
m i p E n t i t i e s . add (new V a r i a b l e B i n d i n g (new OID(" 1 . 3 . 6 . 1 . 2 . 1 . 4 4 . 1 . 1 . 1 . 0 " ) ) ) ; 

c m i H a R e g T o t a l M o b i l i t y B i n d i n g s . se tType (PDU.GET) ; 
c m i H a R e g T o t a l M o b i l i t y B i n d i n g s . add (new V a r i a b l e B i n d i n g ( 

new O I D ( " 1 . 3 . 6 . 1 . 4 . 1 . 9 . 9 . 1 7 4 . 1 . 2 . 1 . 1 . 0 " ) ) ) ; 

c m i F a R e g T o t a l V i s i t o r s . setType (PDU.GET) ; 
c m i F a R e g T o t a l V i s i t o r s . add (new V a r i a b l e B i n d i n g ( 

new O I D ( " 1 . 3 . 6 . 1 . 4 . 1 . 9 . 9 . 1 7 4 . 1 . 1 . 1 . 1 . 0 " ) ) ) ; 

hostnamePDU. setType (PDU.GET) ; 
hostnamePDU . add(new V a r i a b l e B i n d i n g (new OID(" 1 . 3 . 6 . 1 . 2 . 1 . 1 . 5 . 0 " ) ) ) ; 

commTarget. set Community (new O c t e t S t r i n g ( " p u b l i c " ) ) ; 
commTarget. s e t V e r s i o n (SnmpConstants . v e r s i o n 2 c ); 
commTarget. s e t R e t r i e s ( l ) ; 
commTarget. se tTimeout (1000) ; 
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req . commtarget = commTarget; 

s e t t i n g s = new J D i a l o g S N M P S e t t i n g s ( n u l l , t r u e , commTarget , req ); 

t imer . schedule (new T i m e r T a s k Q { 
p u b l i c v o i d run() { 

i f ( l oop_enab led ) { 
o n L o o p ( ) : 

} 
} 

}, 0, i n t e r v a l ) ; 

} 

s t a t i c p u b l i c S t r i n g customFormat ( long va lue ) { 
DecimalFormat myFormatter = new DecimalFormat ( / / / / " ); 
S t r i n g output = myFormatter . format ( va lue ) ; 
r e tu rn output ; 

p r i v a t e vo id getHostname () throws E x c e p t i o n { 
req . c l e a r R e s p o n s e _ t e x t () ; 

/ / z j i s t e n i hostname 
/ / n a s t a v e n i hostnamu na t l a c i t k u 
req . send ( getIP () , hostnamePDU , t r u e ) ; 
hostname = req . r esponse_ tex t . g e t F i r s t () ; 
Rout erB tn . set T e x t (hostname ); 

} 
p r i v a t e vo id c h e c k M I P E n t i t i e s () throws E x c e p t i o n { 

req . c l e a r R e s p o n s e _ t e x t () ; 
req . send ( getIP () , m i p E n t i t i e s , t r u e ) ; 
i f (! req . r esponse_ tex t . g e t F i r s t () . c o n t a i n s (" no Such Object" ) 

! r e q . r e s p o n s e _ t e x t . g e t F i r s t ( ) . c o n t a i n s (" E r r o r " ) ) { 

in t bajt = ( i n t ) req . r esponse_t ext . ge t F i r s t () . char A t (0) ; 

i f ( ( ba j t & 0x40) == 64) { 
fo re ignAgen t = t r u e ; 

} else { 
fo re ignAgen t = f a l s e : 

} 

i f ( ( ba j t & 0x20) == 32) { 
homeAgent = t rue ; 

} else { 
homeAgent = f a l se : 

} 

} 

} 

p u b l i c vo id onLoop() { 
i f ( i s O n l i n e Q ) { 

Route rBtn . se tBackground ( Co lo r . green ) ; 
t r y { 

getHostname () ; 
c h e c k M I P E n t i t i e s () ; 
g e t l f T a b l e () ; 
i f (homeAgent) { 

getHATable () ; 
} 
i f ( f o r e i g n A g e n t ) { 

ge tFATable () ; 
} 

} else i f (! i s O n l i n e ()) { 
Route rBtn . se tBackground ( Co lo r . red ); 

} 
} 

p r i v a t e boolean i s O n l i n e () { 
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t r y { 
adresa = Inet Address . getByName ( t h is . get IP ( ) ) : 
i f ( a d r e s a . i s R e a c h a b l e ( 2 0 0 0 ) ) { 

r e t u r n t r u e ; 
} e lse { 

r e t u r n f a l s e ; 
} 

} ca tch ( I O E x c e p t i o n ex) { 
r e tu rn f a l se : 

p r i v a t e vo id R o u t e r B t n A c t i o n P e r f o r m e d (j ava . awt. e vent . A c t i o n E vent evt ) { 
i f ( i p A d d r j T e x t F i e l d . i s E n a b l e d ()) { 

t r y { 
adresa = Inet Address . getByName( i p A d d r j T e x t F i e l d . getText ( ) ) : 
i p A d d r j T e x t F i e l d . s e tTex t ( adresa . ge tHos tAddress () ) : 
loop_enab led = t r u e ; 
onLoop( ) ; / / o k a m ž i t ě vykonat smyčku , pak dle i n t e r v a l ů 
i p A d d r j T e x t F i e l d . s e t E n a b l e d ( f a l se ) ; 

} ca tch (UnknownHostExcept ion ex) { 
l o o p . e n a b l e d = f a l s e ; 
JOpt ionPane . showMessageDialog (SNMP4MobileIP . getFrames () [0] , 
" N e p l a t n á „ I P „ a d r e s a „ n e b o „ h o s t n a m e " , 

" g p a t n á „ I P „ a d r e s a " , JOpt ionPane .WARNING^TESSAGE) ; 
i p A d d r j T e x t F i e l d . s e t E n a b l e d ( t r u e ) : 

} 
} else i f (! i p A d d r j T e x t F i e l d . i s E n a b l e d ()) { 

l o o p . e n a b l e d = f a l s e ; 
i p A d d r j T e x t F i e l d . s e t E n a b l e d ( t r u e ) ; 
Rou te rBtn . se tBackground ( Co lo r . b lack ); 
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